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An Important Note about Copying and Usage 
Use of the grievance database is restricted to authorized officers and representatives of Unifor 

Local 2002. It is not to be copied or distributed to any other person without the written 
authorization of the President of Unifor or their designated representative. 
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Grievance Tracking & Reporting Database 

Introduction 

The Grievance Tracking & Reporting Database was initially designed to simplify the administration of the 
modified grievance/arbitration process being used at Air Canada and Jazz. As the grievance data has 
accumulated, it has also proved to be a valuable tool for researching grievances. Currently there are 
over 2,400 grievances contained in the database emanating from almost every bargaining unit in CAW 
Local 2002. With the cooperation of everyone involved, the database can continue to grow in both size 
and value. 

The success and usefulness of the database depends upon information being provided by those 
responsible for filing and processing grievances. The Unifor Local 2002 Grievance Coordinator will be 
maintaining and updating the database, but timely and accurate information provided by District 
Chairpersons and Bargaining Committee Representatives will continue be the backbone. 

What you can do to help 
 

• Use the Grievance Report Form and submit it to the Grievance Coordinator by email. 
 

• Fill in the required fields on the Grievance Report Form carefully and accurately. If you’re filling 
it out by hand, make sure your writing is legible. 

 
• When describing the grievance, be descriptive enough so that anyone reading it can figure out 

what the grievance is about. 
 

 
 

• If the grievance concerns discipline/discharge, send the Grievance Coordinator a copy of the 
letter the employee received. This will state why the employee was disciplined/discharged and 
can be used by the Coordinator to complete the grievance database document. 

  

Use this description: Change of shift without required notice on Dec. 1, 2007 

Not this:  Change of shift 
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What Next? 

• If you need to install the required programs, see Appendix 1, “Required Programs and Files” 
starting on page 41. 

• If you want to know about the Grievance Form, see the section “Using the Grievance Report 
Form” starting on page 4. 

• If you need help with the askSam Grievance Program, see the section “Using the Grievance 
Database” starting on page 16. 
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Using the Grievance Report Form 

The Grievance Report Form has been developed to standardize the method of filing grievances. Using 
this form will ensure that the necessary information is provided in a consistent manner across all of the 
Local’s bargaining units and will also make it easier to maintain the grievance database. 

 

The preference is to have the form completed on your computer, but it’s also possible to fill it in by hand 
(as long as your handwriting is legible!).  
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Completing the Form 
To use the form, click on the Grievance Form hypertext link on the top menu. If you’ve elected to save a 
copy of the form on your desktop, double-click on its icon. Either method will open Adobe Reader and 
the Grievance Form. 

 

Completion of some of the fields is mandatory. This will ensure that some basic information required 
when filing a grievance is provided. If you click on Highlight Fields in Adobe Reader, the mandatory fields 
are highlighted with a red outline. 

 

Fields outlined  in 
red must be filled in 

Click for Drop 
Down List 

Click to open a 
blank grievance 
form 
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There are a couple of tools in Adobe Reader that will help you fill in some of the fields. The first is the 
auto-complete feature which will remember what you had entered in other forms and then make 
relevant suggestions as you type into a field. Once you enter a character into a field, a drop-down box 
displays a list of only the most probable matches. Double-click or press Down Arrow in an empty field to 
display an even larger list of possible matches.  

 To activate this feature in Adobe Reader, go to Edit > Preferences and then click on Forms in the left 
hand pane. Under the Auto-Complete section click the down arrow on the right side of the box, select 
Basic from the drop down list and then click OK. If you find the lists are getting too large and unwieldy, 
you can clear some or all of the choices by going through Edit  > Preferences > Forms, clicking on Edit 
Entry List and then performing your desired action. 

 

 

The other tool uses drop down lists which you can use to select the appropriate input. You will know 

you’re in one of these fields when a down arrow  appears to the right of the text entry area.  
  

Select Forms from the 
Edit > Preferences Menu 

Click the down arrow on 
the right and then select 
Basic from the list. 

To clear Auto-Complete 
entries, select Edit Entry 
List. 
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In the Submitted to box, you can either type in the Step the grievance is being submitted to, or you can 
click on the down arrow and select either Step 1 or Step 2:  
 
 

 
 

For date fields, click the down arrow or press the down arrow on your keyboard and a calendar will be 
presented from which you can select a date: 

 

  

Click the arrow 
for a calendar 

Type in the 
Step or click 
and select Step 
1 or Step 2. 
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In the Grievance Type box, click on the down arrow and select which of the two types the grievance falls 
into: 

 

While you’re encouraged to keep them brief and to the point, the violation description and settlement 
requested boxes will expand to fit the text you enter, with the form flowing over to a second page if 
necessary. As you enter the text beyond the original size of the box, a scroll bar will appear on the right 
side. Clicking outside the box, or moving to the next field, will cause the box to automatically resize to 
accommodate all the text that has been entered. 

 

  

Click the arrow 
for a type list 

Scroll bar 
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Once the form is completed, submit it to the responsible Company official, and provide copies to your 
Bargaining Committee Representative, the Grievance Coordinator and keep one for your file.  

If you complete the form by hand - Fax a copy to the Grievance Coordinator, send the 
original to the responsible Company official and make copies to send to your Bargaining Committee 
Representative and for your file.  

  

Clicking outside 
the box will 
expand it. 
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If you complete the form on your computer - Save a copy under its own name on your 
computer (use the Grievance No.).  Click on the Save Form box, select the folder where you want to save 
the file and type in the name of the file in the File Name box.  

 

 

Click on the button on the upper right corner to print out hard copies to send and for your file. Click on 
the Copy to Union by Email button to email a copy to the Grievance Coordinator. 

You will get an error message if you try to email the form without having completed all of the 
mandatory fields. 
 

 
 

Check and make certain that all the mandatory fields have been filled in. If you haven’t already, click on 
Highlight Fields at the top of the window to highlight the mandatory fields in red. 
 
If you’re going to email a copy to the Company, you should first convert the completed form into an 
Adobe PDF file by following the steps in the next section. Converting the form will ensure it cannot be 
changed. 

Click to Print a 
copy of the 
completed form 

Click to Email a 
copy of the 
completed form 
to the Grievance 
Coordinator 

Click to save a 
copy of the 
completed form. 
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Creating an Adobe PDF file 
You can create an Adobe PDF of the completed form by printing it to a PDF Printer. The advantage of 
doing this is that the form is saved in a file that cannot be changed. This file can then be emailed to the 
company (or anyone else) without concern that it might subsequently be altered in some way.  
 
To do this, you must have a PDF printer driver installed on your computer that will print the grievance to 
a file instead of a printer. If you haven’t, see the section “doPDF Printer” starting at page 45 in Appendix 
1. 
 
To print a grievance to a PDF file using the doPDF printer driver, do the following: 
 

1. Use Adobe Reader and the grievance form template to complete the grievance. 
 

2. Click on the Print Form button on the form to bring up the printer dialog. 
 

 
 
 
 

3. Click on the down arrow to the right of the printer name to bring up the list of printers installed 
on your computer. Click on doPDF to select it as the Printer to be used for printing the form. 
Click OK. 
 

Click on the Print 
Form button to 
bring up the 
printer dialog 
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4. At the next prompt, click on Browse, select the folder where you want to save the file and type 
in the name of the file in the File Name box. Click on OK to continue. You will have to give the 
file a name that is different from the name of the file you are printing from. 
 

5. Adobe Reader will reopen and show you the newly created PDF file. If you are using Outlook or 
Outlook Express to handle your email, you can click on File > Attach to Email to bring up a blank 
message with the completed form attached. If you use an internet based email client like 
Hotmail, Yahoo or Gmail, you need to manually attach a copy of your saved form to an email. 

 

 
 

Click on the 
down arrow, 
then on 
doPDF and 
then Print. 

Click on File 
> Attach to 
Email to 
attach the 
form to an 
email. 
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If you want to print a hard copy, click on the printer icon to bring up the print dialog. If the doPDF 
printer is still shown in the printer name box, click on the down arrow and choose your regular printer. 

 

  

If doPDF is still 
shown in the 
printer name 
box, click the 
down arrow and 
choose your 
regular printer. 

Click on the 
printer icon 
to bring up 
the print 
dialog 
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Grievance File Numbering 

To help organize our grievance cataloguing and tracking system, a standardized numbering system for 
grievances that are filed across the system is being implemented. This will ensure that each grievance 
filed will have its own unique number, and make it easier to zero in on a particular grievance in the 
system. 

For all Districts except those which encompass more than one base, the format is: 

District No. – Grievance Sequence No. (at least 2 digits) – Year (2 digits) 

For example, if District 100 is filing their 5th grievance in 2007, the number would be: 

100-05-07 

And if District 319 is filing their 12th grievance in 2007, the number would be: 

319-12-07 

 

For Districts which encompass more than one base: 

Add the airport code for the base in which the grievance originated: 

District No. – Base Grievance Sequence No. (at least 2 digits) – Year (2 digits) – Base City Code 

For example, if District 344 was filing their 2nd grievance in 2007 for Sioux Lookout, the number would 
be: 

344-02-07-YXL 

Note that for Districts encompassing more than one base, the Grievance Sequence No. is based on the 
number of grievances filed in the Base, not the District. Thus, it doesn’t matter that this may be the 
tenth grievance filed by District 344 in 2007 – what is counted is that it’s the second grievance filed out 
of YXL/Sioux Lookout. 

If your numbering system is different, please switch to this format as soon as possible. If sequence 
numbers have been used in your system, continue with the sequence but in the new format. 

Policy Grievances 

For Policy grievances filed by a Bargaining Committee representative the format is: 

P - (Unit identifier) – Grievance Sequence No. (at least 2 digits) – Year (2 digits) 

Use the following Unit identifiers: 
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Unit Identifier 

Aeroplan AP 

Air Canada Customer Service ACC 

Air Canada Crew Scheduling ACS 

Airport Terminal Services ATS 

Jazz Customer & Aircraft Services QKC 

Jazz Crew Scheduling QKS 

Jazz Technical Services QKT 

Airport Terminal Services ATS 

American Airlines AA 

Canadian North CAN 

CLS Catering CLS 

Dryden Air Services DAS 

First Air 7F 

GTAA GTA 

Handlex HDX 

Hilton HIL 

Imperial Parking IPK 

Morningstar Air Express MAE 

ORNGE – Ont. Air Ambulance OAA 

Servisair SER 

Skyservice SKY 

United Airlines UAL 

Webb Airport Services WAS 

Worldwide Flight Services WFS 

 

For example, the 5th policy grievance filed by Jazz Technical Services in 2007 would be: 

P-QKT-05-07 
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Using the Grievance Database 

Starting the Program 

Assuming you have all of the database components properly installed on your computer,  you can start 
the program by double-clicking the shortcut icon on your desktop, or opening the Grievances folder and 
double-clicking on the GRIEVANCES.ask icon.  

   

Note: The Grievances file will also have the release month and year in its name. For example, the file 
name for the August 2013 release is GrievancesAug13.ask. 

The askSam Viewer Screen 

The first time you open the file, you will be asked if you want to index the file: 

 

Click on Yes, and then on Index File: 

 

When the indexing is finished, click on Close: 
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The Top Menu page will then display and will look something like this: 

 

 

On the upper left side of the screen is what’s known as Folder View window. This window can closed or 
opened by selecting  View > Folders. The lower left side window shows the attachments to the 
document which is being viewed on the right side of the screen.  This window can be closed by clicking 
on the ‘x’ in the upper left corner and can be opened again by clicking the paper clip icon in the lower 
bar of the right side of the screen.  

 

Folder view 

Attachments 

Paper Clip 
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The Screen Layout 

 

 

The first line on the screen is the TITLE BAR. It contains the name of the active application ( askSam) and 
the name of the active file (GrievancesAug13). 

The second line on the screen is the MENU BAR. From here you can access askSam Viewer's pull-down 
menus. While the basic functions  of the grievance system are accessed through the links on the Top 
Menu document, the Menu Bar provides many more. Feel free to experiment. 

The third line is the TOOL BAR. It contains Buttons (also sometimes called Icons). These Buttons provide 
quick access to askSam Viewer’s functions. 

The line beginning with the Search button is the SEARCH LINE. Here you can directly type requests for 
searches. You move to the Search Line by pressing the ESC key or CLICKING on the Search Line. After you 
enter a search, press ENTER or CLICK on the Search Button. askSam will search for your request. The 
Search Line also contains two buttons that affect searches. The Case Sensitive button toggles the Search 
from Case Sensitive to Non-Case Sensitive. The Fuzzy Search button turns on and off askSam's Fuzzy 
Search feature. 

Title Bar 

Menu Bar 
Tool Bar 

Search Line 

Text Area 

Horizontal Scroll Bar 

Status Bar 

Vertical Scroll Bar 

Case Sensitive Search 

Open Search Dialog 

Fuzzy Search 

Release Date 

Click to open the 
User guide 
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Underneath the Search Line is the TEXT AREA. This is where the information contained in the Grievances 
file is displayed. The opening document, works like a menu from which you can access most of the 
functions you’ll be using. This is called the Top Menu document. 

Horizontal and Vertical Scroll Bars are located at the bottom of your Text Area and on the right hand 
side of your screen. With these bars you can scroll through the document on screen using a mouse. 

The Horizontal Scroll Bar also contains buttons    in the lower left corner that let you move to the 
First, Previous, Next, or Last Document in the active askSam file. These buttons are also contained in the 
Toolbar at the top of the screen. 

The bottom line on the screen is the STATUS BAR. Here askSam provides you with messages and 
information about your location on screen. It also contains a Document Counter which tells you which 
document you are at out of the total number of documents that are in the system.  

There is also a SEARCH RESULTS Window that will appear underneath the Text Area – after you’ve 
entered a search. The Search Results Window displays a list of the Documents found by a search. Click 
on any item in the Search Results Window to display it in the Work Space. This will be explained in more 
detail later on. 

With the Search Results Window open 

 

 

Search Results 
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Navigating Through the Database 

The Grievances database is comprised of individual data documents. Most contain information on a  
grievance which has been filed. Others contain menus from which other information can be accessed. 

The Top Menu 
The first document in the database is the Top Menu: 

 

The text that is blue and underlined are Hypertext Links that provide a direct link to commands and 
documents that are frequently used. Hypertext links are used throughout the database. Move your 
cursor to the Hypertext and click to access the command or document. 

You can also scroll back and forth through documents by clicking on the left and right arrow   
Video Buttons contained in the Tool Bar or the Horizontal Scroll Bar. The two outermost buttons will 
take you to either the very first or last document.  

Hypertext 
Links 

Video Buttons 

History Buttons 
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If you want to retrace your steps, use the History buttons   contained in the Tool Bar. 

Grievance Documents 

Details for each grievance are entered into individual documents based on a template. Each document 
contains fields into which specific information is entered as it becomes available.  At the top of the 
document are Hypertext Links for moving around the database. At the bottom there is a Hypertext Link 
which will open the window with the list of attachments (copies of letters, emails, decisions, etc.) that 
are relevant to that particular grievance. In some cases, there is also a link to the document containing 
the Teplitsky decision that applies to the grievance. 

 

 Attachment “Paperclip” 
Click to open attachments 
window. 

Click to open  attachments 
window 

Click to go to Teplitsky Orders document 

Hypertext Links 

These links only work in the 
Coordinator version 

Fields 
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Fields in the Entry Form 
Fields provide structure for the information in each document and make it easier to focus searches 
within the database. The following table explains what each field contains. This listing is also available 
through the “Fields in the Entry Form Help” Hypertext Link on the Top Menu. 

Field Information 
Grievance State Shows if the grievance is open or closed. 

Open = Still in process 
Closed = Grievance has been resolved or withdrawn 

Company Short forms are used to identify the Company involved: 
*All* - This is used for searches only. 
AP = Aeroplan 
AC = Air Canada 
Crew Sked = Air Canada Crew Sked 
AirCan Vacations = Air Canada Vacations 
AF = Air France 
ATS = Airport Terminal Services 
American = American Airlines 
AE = American Eagle 
Cdn North = Canadian North 
CLS = CLS Catering 
Dryden = Dryden Air Services 
First Air = First Air 
GTAA = GTAA 
Handlex = Handlex 
Hilton = Hilton YSJ 
Imperial = Imperial Parking 
JazzCW = Jazz Crew Sked 
JazzCS = Jazz Customer Service 
JazzTS = Jazz Tech Services 
Morningstar = Morningstar 
OAA = Ornge (Ontario Air Ambulance) 
SER = Servisair 
Skyservice = Skyservice 
UAL = United Air Lines 
Webb = Webb Airport Services 
WFS = Worldwide Flight Services 

Monthly Review The date of the first monthly review that the grievance was scheduled to 
be dealt with. 

Grievance Level Specifies if the grievance is being heard at Level 1, Level 2 or arbitration. 
The level is updated if the grievance goes to arbitration. 
1 = Level 1 
2 = Level 2 
Arbitration 
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Field Information 
Status The current status of the grievance. Updated as the grievance 

progresses. 
Level 1 outstanding 
Level 1 heard - denied 
Level 2 outstanding 
Level 2 heard - denied 
Settled 
Settled at monthly review 
Adjourned pending 
Held in abeyance 
Returned for further discussion 
Referred to pre-hearing officer 
Referred to arbitrator 
Arbitration Scheduled 
Withdrawn 
Resolved 
Dismissed 

BC Rep Name Name of the Bargaining Committee Rep responsible for the grievance. 
Grievor Name Who is covered by the grievance. Can also be Policy or Group. 
District # The CAW District # from which the grievance was filed. Policy grievances 

that aren't attached to a District are shown as "HQ". 
Union Ref # The number assigned by the Union for each grievance filed. 
Grievance Filed Date the grievance was originally filed. 
Grievance Type Specifies what type of grievance it is: 

Interpretation/Application 
or 
Discipline/Discharge 

Grievance Subject Identifies the Article/LOU/MOU violated or if the grievance involves 
Discipline or Discharge. 

Grievance Category Narrows the subject matter of the grievance, ie Wages, Benefits, 
Vacation, Discipline, etc. 

Offence Category Used for discipline/discharge cases. Describes the type of offence for 
which the grievor has been disciplined (eg attendance, theft, 
insubordination, etc). 

Final Decision Describes the outcome of grievance ie, what was decided. Input when a 
final decision is made. 
settled = a settlement was reached by the parties 
upheld = a decision was issued upholding the grievance 
partially upheld = a decision was issued partially upholding the grievance 
dismissed = a decision was issued dismissing/denying the grievance 
withdrawn = the Union withdrew the grievance 

Final Decision Reasons Outline of the reasons given for the decision. If a Monthly Review 
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Field Information 
decision is brief, the whole decision would be included. 

Decision By Name of the manager/arbitrator who made the final decision. 
Decision Date Date of the final decision. 
Grievance Substance The description of the grievance used when the grievance was filed. 
Grievance Facts A brief detailed description of the facts. This field isn’t used very often. 
Remedy Description of what has been requested by the Union as a remedy for 

the violation. 
Comments Place for free-flow comments that don’t fit anywhere else. Will often 

contain information on the status of the grievance as it progresses 
through the process. 

Hearing Notes This is sometimes used by the Grievance Coordinator as a place for notes 
taken during a Teplitsky hearing. 

Date First Entered The date the grievance was first entered into the database. 
 

Attachments 

Most documents have attachments included. Usually a copy of the original grievance will be attached, 
and often there will be a copy of any decisions that have been received. There may also be copies of 
emails or other documents associated with the grievance. If the Attachments window is open, the 
attachments will be listed. If the window is not open, you can tell at a glance if a document has 
attachments by looking at the attachment paperclip next to the Video Buttons on the bottom left of the 
askSam screen. 

 A dimmed paperclip button means there are no attachments. 

 A highlighted green paperclip means attachments are included. 

To access the attachments, you can either click on the paperclip, which will open the window with the 
list of attachments if it is not already open. Click on the name of the attachment to view it. 
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If you wish to close the attachments window, click on the ‘x’ in the upper right hand corner of the 
window. 

Attachments are limited to 3 types:  

Adobe Acrobat .pdf files – You must have Adobe Acrobat Reader installed on your computer to view 
these files and it should be the latest version. If you don’t have it installed, it can be downloaded free 
from www.adobe.com. This application is also required for the Grievance Form. 

Picture files – Occasionally, as in the above examples, photographs or other picture files (a copy of a fax 
for example) may be attached. Windows includes a picture viewer so no additional programs are 
required to view these files. 

Text files – These files have a .txt extension and usually contain copies of an email or other simple notes. 
Windows includes a notepad application which can display these files.  

Click on the hyperlink or the 
paperclip to open the 
attachment window. 

Click on the file name to view 
the attachment. 

Attachments window 
Click the ‘x’ to close the 
window. 
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Attaching files created by word processing programs (eg. Microsoft Word) is limited because these can 
only be viewed on computers that have those programs installed. There may be the odd attachment of 
this type in the database that you won’t be able to view if you don’t have the program installed. Also, 
you may happen upon an Acrobat .pdf attachment that Acrobat Reader is unable to open because of file 
corruption. In either event, let the Grievance Coordinator know so the attachments affected can be 
updated.  
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Searching 

This is the most important and powerful function of the Grievance database. By using the search 
functions that are available, you can be as broad or narrow as you like in your search, depending on how 
specific you need the results to be. For example, you can just search for all grievance documents 
containing a particular word (a broad approach) or you can search for all grievance documents 
concerned with a particular issue, filed with a particular company in a particular base within a particular 
period of time (a narrow approach). The results you want will determine which of the search functions 
you use. 

The Broad Approach 

The easiest way to search is from the Search Line: 

 

 

By using the Search Line, it doesn’t matter where in the document the search term is located – the 
entire document will be searched and any that contain the search term will be displayed.  

Press the ESC key, or click in the Search Line, and type the search term. askSam will then search all of the 
documents from the beginning of the file to the end, the Search Results window will open and all of the 
documents that contain the search term will be listed with the first document found being displayed in 
the top half of the screen.  

From the Search Results window you can: 

• Scroll through the list and click on any that might be of interest to see the full document.  
• See the context of the hit in the document. 
• See the number of documents retrieved by your search. 

If you’re not sure of the spelling, click on the Fuzzy Search toggle button.  For example, if you were 
looking for Documents containing the name "Kathy". You could use askSam's fuzzy search and find 
Documents with "Kathy", "Kathi", or "Cathy". The Fuzzy Search overlooks a single error in a word, which 
can be a missing letter, an extra letter, an incorrect letter, or a transposition (two neighbouring letters in 
reverse order). When you’re finished with fuzzy search, make sure you click on the button again to turn 
it off. 

Enter your search term here Fuzzy Search toggle button 
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Here’s an example of the results using the Search Line to search on the word “sick”. 

 

 

 

 

 

When the search is initiated, the Search Results window opens and displays a summary list of 
documents containing the search term. In the list, the first document is highlighted and the complete 
document is displayed in the workspace above the list. You can move from document to document by 
using the arrow keys on your keyboard (make sure the search results window is active), or by clicking 

Search results Use the scroll bar to 
move up or down in 
the list 

Number of 
documents 

found 

Click the ‘x’  to 
close the 

search results 
 

Click to open or close 
the search results 
window 

Click to print the document 
that’s displayed 

Use these buttons to move through the search 
results or use the arrow keys on your keyboard. 
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with your mouse on the document in the list, and the complete document will display in the workspace 
above. You can also scroll through the list using the scroll bar until you see a document that might 
interest you, then click on it to display the full document in the workspace.  

 

To close the search results window, you can either click on the ‘x’ in the upper right corner of the 
window, or click on the Search Results icon in the Tool Bar. 

The Narrow Approach 

In the example used for the broad search, 68 documents were found to contain the search term “sick”. 
By using a more narrow approach, you can zero in on grievances that may be more relevant to what 
you’re looking for. 

Say you want to still search on “sick”, but want the search restricted to documents where the grievance 
involved an appeal against discipline or discharge by an employee in the Jazz Technical Services unit. 
Begin by clicking on small downward triangle next to the Search button on the right side of the search 
line. 

 

 

 

And then select “Advanced” from the drop down list: 

 

The Video buttons on the Tool Bar and Horizontal scroll bar do not follow your search results and 
will take you from document to document in their physical order in the database. 

Click on the small downward 
triangle next to the Search 

button 

Select Advanced 
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This will open the Search Dialog: 

 

 

The Search Dialog can also be opened by selecting Actions/Search using the menu bar. 

 

 

The search buttons on the left of the Search dialog are search options and choosing a button will open 
the dialog for that search. Because the type of searching you will be doing will usually involve using the 
Word and Field buttons, this description will deal only with those.  

 

To begin the search, click on the Word search button to open the dialog. Under Word or Phrase, type 
“sick” (without the quotes) and then click on OK. 

Help on all aspects of the askSam Reader program is always available by clicking Help in the 
Menu Bar, or in any dialog box or by clicking on the Help button  in the Tool Bar. 

Search buttons Click to open Help 

The Search Dialog can 
also be opened by 
clicking Actions and 
then Search.  
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Enter your 
search term 

here 

Click on Word to 
open the search 

dialog 
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This will enter the search for the word “sick” into the Search list: 

 

Then, because we want to narrow the search to grievances involving an appeal against discipline or 
discharge by an employee in the Jazz Technical Services unit, two other search criteria have to be 
entered. Both of these criteria are contained in fields that are contained in the Grievance Document, 
discipline/discharge being contained in the Grievance Type field and JazzTS (the shortform used for Jazz 
Technical Services) being contained in the Company field. Therefore, in defining your search, you’ll want 
to tell askSam to search in the Grievance Type field for the word discipline (or discharge – it’s not 
necessary to specify one or the other since both are contained in the field) AND to search in the 
Company field for the word JazzTS. 

To do this, click on the Field button and type “discipline” into the box under Find Word or Phrase. Next, 
click on the down arrow next to the In Field Box to open the list of fields, scroll down to Grievance Type 
and click on it, then click OK. This will enter the search for the word “discipline” in the Grievance Type 
field into the Search List. 
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Next, click on the Field button again, type “JazzTS” into the Find Word or Phrase box, open the list of 
fields, click on Company and then OK. This will enter the search for the word “JazzTS” in the Company 
field into the Search List. When you’re finished, the Search Dialog will look like this: 

Click the down 
arrow to open the 
field list 

Click on Field to 
open the search 

dialog 

Enter your search 
term here 

From the list, 
select the field 
to search in 
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JazzTS is the short form for Jazz Technical Services. Always use the short form when searching for a 
company. A complete listing of the short forms can be found under the section “Fields in the Entry 
Form” on page 21, or in the document ‘Fields in the Entry Form Help’ available from the Top Menu. 
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Click on the OK button for the search results. As you can see, narrowing the criteria to what’s most 
relevant to your search, results in your being presented with three grievance which satisfy that criteria: 

 

Pre-programmed Searches 

Sometimes, you’ll want a simpler way of narrowing your search, or you’ll want to see information on 
more grievances displayed on the screen when doing a search. Or you’ll want to have a printed list, 
instead of print outs of each individual grievance document. All can be accomplished by using the 
Reports and Research function.  

This function provides a variety of preprogrammed searches where the work of defining the search logic 
has already been done and where the information resulting from the search is presented in summary 
form. A description of all of the reports can be obtained by clicking on the Reports & Research Help link 
on the Top Menu: 

The specified search 
criteria is highlighted 

Click to print the 
document that’s 

displayed 
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From here, you can run a report by clicking on the hypertext links for each report (the blue underlined 
heading). You can also run reports by clicking on the Reports & Research Hypertext link on the Top 
Menu, or by clicking on the Reports button  on the Tool Bar when you’re anywhere in the database. 
Whichever you choose, a listing of the reports available will be given and you can select the one you 
want to run. Once a report is selected, prompts are presented where you can select the search criteria 
from a list, or in some cases you will need to type in your search term, and then the report with the 
results will be displayed on your screen. 

To print the report that’s displayed, click the Printer icon on the Tool bar. In the Print Dialog, next to 
your printer name, click the Properties button and make sure the settings reflect that the document will 
print on legal-size paper in landscape orientation.  Also make sure your printer is loaded with sufficient 
legal size paper. Once your settings are adjusted and the paper is loaded, click the OK button to start 
printing. 

Click on the 
hypertext link to 

run a report 

Click on the 
Reports button 

to display a list of 
reports. 
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If you see a grievance listed on the screen report that you want more information on, double-click 
anywhere in the row on the report and the full grievance document will be displayed. To return to the 
report, click on Window in the Menu bar and select the Report that you want. 

Here’s an example using Article Search: 

If you’re at the Top Menu, click on the Reports & Research hypertext link to open the Report Manager. 
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You can also open the Report Manager by clicking on the Reports button  on the Tool Bar when 
you’re anywhere in the database. 

 

From the list in the Report Manager, click on Article Search and then on Run. 

 

The first prompt asks for the Unit you want the search to focus on. If you want to search through all 
Units, just click OK to select All. In this example, we’ll narrow the search to the Ont. Air Ambulance Unit 
by clicking on the down arrow on the right of the dialog and then clicking on the Unit name in the 
picklist that’s presented.  
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Click on OK to get to the next prompt which asks for the type of violation you’re searching for. In this 
example, we’ll narrow the search to Overtime & Recall by clicking on the down arrow on the right of the 
dialog and then clicking on Overtime & Recall in the picklist that’s presented. 

 

A report will then be presented in a separate window listing all of the grievances in the database which 
meet the search criteria. 

 

Click on the 
‘x’ to close 
the report.  

Double-click 
anywhere 
between the 
dotted lines to 
switch back to 
the main 
window with 
the full 
document.  

Click on the 
Grievances tab 
to switch back 
to the main 
window. 

When in the 
main window, 
click on the 
Report tab to 
return to the 
report. 



 

  Sept. 2013 40 

A copy of the report can be printed by clicking on the printer icon in the toolbar. 

 

To view the full document, double-click anywhere in the line on the report containing the summary. This 
can be done any number of times from the report window so it’s easy to view the individual grievance 
documents contained in the report simply by switching back to the report window and double-clicking 
on the next grievance you want to view. 

To switch back to the main window without closing the report, click on the tab with the Grievances file 
name on it. You can access the report again by clicking on the report tab. To close the report, click on 
the ‘x’ in the upper right when in the reports window.  

 

  

All reports are formatted for printing on legal size paper in landscape orientation. Make sure 
your printer settings are changed so the report prints properly!  
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Appendix 1 - Required Programs and Files 
The following programs and files must be installed on your computer in order to take full advantage of 
all the features of the Grievance Tracking and Reporting database. All of the programs are easily 
downloaded from the internet and installed onto your computer without difficulty – and they’re free! If 
don’t have a high-speed internet connection or are otherwise technically challenged, please contact the 
Grievance Coordinator for help. 

 Adobe Acrobat Reader 
The grievance form template and askSam require that you have the most recent version of Adobe 
Acrobat Reader (currently version 9.1) installed on your computer. If you don’t yet have it , or if you 
have an older version installed, you can download and install the latest version from www.adobe.com. 

Grievance Form Template 
The template is included in the Grievance database file and can be opened from the top menu: 

 

If you prefer to also have the template available through an icon on your desktop, open the template 
from within askSam and then save the file from the File > Save menu in Acrobat Reader, selecting the 
Desktop folder (or some other folder you prefer) as the location in which to save it. If you do this, make 
sure you protect the template file against accidental changes by following these steps: 

1. Click on the Grievance form.pdf icon on your desktop to highlight it. 

Click to open a 
blank grievance 

form 
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2. With the icon highlighted, click your right mouse button (assuming you’re using a right-handed 
mouse) to open the dialog. Click on Properties on the list. 

 

3. Make sure the Read-only box is checked. If not, click in the box to check it. Then click on OK. 

 

As long as the Read-only box is checked, the file will be protected against changes. 

  



 

  Sept. 2013 43 

askSam Viewer Program 

The askSam Viewer Version 7 program must be installed on your computer in order to open the 
grievance data file. it can be downloaded and installed from: 

http://www.digifile.ca/caw2002files 

When prompted enter the User name and Password included with the email sent announcing the new 
release of the grievance database. 

 

 

The next screen will list the files available for downloading. For example: 

 

From here, click on asviewsetup.exe to start the download and then Save to designate where you want 
the file saved on your computer. Saving it to your Desktop will make it easy to find for the next step. 

At the prompt, 
enter the user 
name & password. 

http://www.digifile.ca/caw2002files�
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Once the download is complete, there will be an icon like this on your desktop:  

 

Double-click on this icon to start the installation process. Follow the prompts from there to complete 
the installation. 

Once the installation is complete, there may be a askSam Viewer icon on your desktop: 

 

Since this icon is not necessary, you can delete it from your desktop if you wish.  You can also delete the 
asviewsetup.exe file from your desktop. 

Grievance Data File 

This is the file where all of the grievance data is stored and you must have the askSam Viewer installed 
in order to open it. The file is usually updated quarterly and an email is sent out announcing the release. 
The email will include instructions on how to download the file over the internet and save it to your 
computer.  

  

Click on 
asviewsetup.exe to 
start the download 

Then click on Save 
to save the file to 
your computer 
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Associating the Grievances file with the askSam Viewer Program 

If the Grievances icon looks like this: 

 

instead of this: 

 

you need to manually associate the Grievances file with the askSam Viewer program. You will only have 
to do this once. 

Here are the steps to follow. The screenshots are from Windows 7 – other versions follow the same 
basic steps but the screen will look different than what’s shown below: 

1. After you’ve installed the file onto your computer, double-click on the Grievances icon, or on the 
shortcut icon you placed on your desktop.  

2. You will get the response that Windows cannot open the file. Click on the dot next to Select the 
program from a list and then click OK. 

 

  

Click on the dot 
next to Select the 
program from a 
list and then OK 
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3. When the Open With dialog opens, click on Browse. 

 

 

4. At the next Open With dialog, double-click on the askSam Folder.  

 

 

Click on Browse  

Double-click on 
the askSam folder 
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5. If you don’t see the askSam folder, use the file browser to navigate to the Program Files (x86) 
folder & you’ll find it there. 

 

 

 

 

Double-click on Local Disk (C:) 

Double-click on  the 
Program Files (x86) 
folder 
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6. Once you’ve navigated to the askSam folder, double-click on the askSam 7 Viewer folder. 

 

  

Double-click on 
the askSam 7 
Viewer folder 

Double-click on the  
askSam folder 
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7. Make sure the ASViewer.exe icon is selected (as it is below) and then click on Open. 

 

 
8. Make sure the askSam 7 icon is selected (as it is below) and click on OK. 

 

The Grievances file will now open in the askSam Viewer program. 

  

Click on Open 

Make sure the 
ASViewer icon 
is selected. 

Click on OK 

Make sure the 
askSam 7  icon 
is selected. 
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doPDF Printer Driver 
The doPDF printer driver allows the creation of PDF files using the print command in any application, be 
it word processing, spreadsheet or email.  

You can use the doPDF printer driver to save a completed grievance form in a file that cannot be 
changed. This file can then be emailed to the company (or anyone else) without concern that it might 
subsequently be altered in some way. 

The first step is to install the doPDF printer driver onto your computer. Once the installation process is 
started, the setup wizard will take you through the steps involved. The following describes these steps 
and how you can answer some of the prompts. 

The doPDF-7.exe installation file from is available through the same link as for the askSam Viewer 
program and data files. Once the file has been downloaded onto your computer, go to the folder with 
the downloaded file and double-click on the doPDF icon to start the installation process. 

 

You will be asked to confirm that you want to run the file (click on Run to continue). You’ll then be asked 
for the language you want the installation process to use and then you’ll be taken to the Welcome 
screen. Click Next to continue. 

 

 

 

 The usual legal statement will come up. You can read it if you like, but you’ll have to click on “I accept 
the agreement” and then Next to proceed to the next screen. 
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At the next screen you’ll be asked to confirm which folder the printer will be installed in (the default 
location selected by the program is fine). You can also accept the default location for the Start Menu 
shortcut. 

 At the next screen you’ll be asked “Do you want to select doPDF printer as the default printer?” – make 
sure that the checkmark is cleared. If there is a checkmark in the box, click on it to clear it. Then click the 
Next button. 

 

 At the Ready to Install screen, click on Install to complete the process. 

 

When the installation process is complete, you can delete the downloaded doPDF file from the folder it 
was saved in. 

Make sure this 
box is empty 
(not checked) 
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Creating an Adobe PDF file with doPDF 
Once the doPDF printer is installed it can be used to create a PDF file of your completed grievance 
forms. The advantage of doing this is that the form is saved in a file that cannot be changed. This file can 
then be emailed to the company (or anyone else) without concern that it might subsequently be altered 
in some way. 
 
To print a grievance to a PDF file using the doPDF printer driver, do the following: 
 

1. Use Adobe Reader and the grievance form template to complete the grievance. 
 

2. Click on the Print Form button on the form to bring up the printer dialog. 
 

 
 
 
 

3. Click on the down arrow to the right of the printer name to bring up the list of printers installed 
on your computer. Click on doPDF to select it as the Printer to be used for printing the form. 
Click OK. 
 

Click on the Print 
Form button to 
bring up the 
printer dialog 
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4. At the next prompt, click on Browse, select the folder where you want to save the file and type 
in the name of the file in the File Name box. Click on OK to continue. You will have to give the 
file a name that is different from the name of the file you are printing from. 
 

5. Adobe Reader will reopen and show you the newly created PDF file. To email the form, click on 
File/Send File: 

 
 

 

Click on the 
down arrow, 
then on 
doPDF and 
then on 
Print. 

Click on File 
> Send File 
to attach 
the form to 
an email. 
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If you want to print a hard copy, click on the printer icon to bring up the print dialog. If the doPDF 
printer is still shown in the printer name box, click on the down arrow and choose your regular printer. 

 

If doPDF is still 
shown in the 
printer name 
box, click the 
down arrow and 
choose your 
regular printer. 

Click on the 
printer icon 
to print a 
hard copy. 
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